CHAPTER 3

Spatial data input
Analysis and modeling in a GIS requires input of relevant data. The data consist of
two types: spatial data representing geographic features (points, lines and areas) and
attribute data (descriptive information). Data input should be done with utmost care,
as the results of analyses heavily depend on the quality of the input data. In ILWIS
data can be entered by:
- Digitizing, if you want to use data from analog (paper) maps;
- Keyboard entry, for entering tabular data;
- Scanning, if you want to use paper prints of satellite images, aerial photographs,
maps and pictures;
- Importing existing data files from other sources.
This chapter explains how to digitize maps. The next chapter deals with the import of
digital map data and in chapter 5 the import and creation of tables is treated.
Before you can start with the exercises, you should start up ILWIS and change to the
subdirectory C:\ILWIS 3.0 Data\Users Guide\Chapter03, where the data files for
this chapter are stored.
Apart from a segment map used in section 3.5, you will create all digital data for this
chapter yourself.

☞

•
•

Double-click the ILWIS icon on the desktop.
Use the Navigator to go to the directory C:\ILWIS 3.0 Data\Users Guide\
Chapter03.

Introduction to digitizing
The most common method of entering spatial data in ILWIS is digitizing. Features on
a paper map or other analog documents (e.g. a photo-interpretation on a piece of
tracing film) can be digitized. This can be done using a device called a digitizing
tablet, or digitizing table, or simply digitizer. A digitizer contains a pointing device
(digitizer cursor) to trace spatial features. The position of the digitizer cursor is
registered electronically to a precision of fractions of a millimeter. This is done
through a fine grid of wires embedded in the digitizer (Figure 3.1).
The vertical wires record the X-coordinates; the horizontal ones the Y-coordinates.
The range of digitizer coordinates depends, amongst other things, on the density of
the network of wires: digitizer resolution. The cursor contains a small transparent
window with a cross-hair, and a number of buttons (at least four buttons are needed
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to work with ILWIS). When you press one of the buttons, an electromagnetic signal is
transmitted and the position of the cross-hair is recorded by one of the horizontal and
one of the vertical wires. From this, a coordinate pair in digitizer units is defined and
sent to the computer.

Figure 3.1:
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Operation of a digitizer (simplified).
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3.1 Map coordinates versus digitizer coordinates
3.1.1 Creating a coordinate system
Before you can start digitizing, you should first pay attention to the coordinate
system in which you will digitize your map. You may for instance use user-defined
coordinates, coordinates defined by a national standard or coordinates of a certain
UTM zone.
The information on the map coordinates you use in a project, is stored in a
coordinate system. A coordinate system defines the possible minimum and maximum
X’s and Y’s that can be used in one or more maps, along with other information on
map datum, projection, etc., as was mentioned in the previous chapter. A coordinate
system may include a projection, which defines the relationship between map
coordinates and geographic coordinates in latitude and longitude.
In ILWIS, there are seven main types of coordinate systems:
- Boundary Only: corners of map in X,Y; no projection possible.
- Projection: corners of map in X,Y; optional projection and optional ellipsoid and
datum.
- LatLon: corners of map in LatLon; optional ellipsoid and datum.
- Formula: coordinates calculated by mathematical formula based on another existing
coordinate system.
- TiePoints: table with pairs of coordinates (master-slave) to define a relation
between the two, using a conformal, affine, second order, projective, etc.
transformation.
- Direct Linear: to digitize vector features from an (hardcopy) aerial photograph on
the digitizer. Table containing XYZ coordinates and digitizer coordinates. DTM of
the area required; no fiducial marks on aerial photograph.
- Ortho Photo: to digitize vector features from an (hardcopy) aerial photograph on the
digitizer. Table containing XYZ coordinates and digitizer coordinates. DTM of the
area required; fiducial marks on aerial photograph and camera information required.
ILWIS has three standard coordinate systems:
- LatLon: Geographical coordinates in degrees.
- LatLonWGS84: LatLon coordinates, using WGS84 datum and ellipsoid.
- Unknown: This is the coordinate system you can use if you do not want to specify
the projection used in your maps. In that case you define your own local coordinate
system; only the minimum and maximum X and Y values are stored and there is no
need for projection parameters.
In principle, all the maps that are used of a certain area should have the same
coordinate system. ILWIS expects that all maps that you want to superimpose or
display together in one map window have the same or a compatible coordinate
system. Therefore, when you start with a project you first create a user-defined
coordinate system, and you use this for all the maps that you digitize or that you
import from other sources.
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For maps with different projections, different coordinate systems (of type projection)
have to be created. To display two or more maps with different projections an ILWIS
map window automatically ‘transforms’ the coordinates of the second map to the
projection of the first one. You can use the Transform operation to permanently
transform maps with different projections to one common projection.
Sometimes you may not know the projection of a map that you are going to digitize.
In that case you cannot fill in the projection parameters in the coordinate system, and
therefore, you don’t know the relationship between metric and geographic
coordinates. This is not a problem as long as you don’t want to combine your data
with maps in other projections.
We strongly advise you not to digitize your map in a coordinate system that you
invent yourself, for example just by taking the lower left corner of the map as X = 0
and Y = 0. If you do so it will be very difficult to combine your own digitized data
with that from other sources.
Normally, topographic maps contain information on the map projection that was
used. For example, on the topographic map of Cochabamba, the following
information is given:
- Ellipsoid: International .
- Projection: Transverse Mercator .
- Vertical Datum: Sea level .
- Horizontal datum: Provisional South America 1956 .
- UTM zone: 19 K.
In the next chapter, you will find a more elaborate explanation on map projections,
and especially on UTM.
The map that you are going to digitize first, is shown in Figure 3.3. You can see from
the map that the actual study area is located between the following coordinates (in
UTM zone 19):
- minimum X = 795000
- maximum X = 808500
- minimum Y = 8071500
- maximum Y = 8090500
Now that you know the coordinate boundaries of your map and the projection
information, you can generate the coordinate system that will be used for all maps of
the Cochabamba area.

!
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Note that if you want to extend your study area and digitize adjacent areas you
need to extend the range of coordinates as defined in the coordinate system.
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☞

•

Double-click the New Coordinate System item in the Operation-list. The
Create Coordinate System dialog box is opened.

•
•
•

Type for the Coordinate System Name: Cochabamba .

•
•
•

Click the Projection button and select the Projection: UTM .

Type for the Description: Coordinate system of Cochabamba in UTM .
Select the option CoordSystem Projection and click OK. The
Coordinate System Projection “Cochabamba” dialog box is opened.
Click OK in the Select Projection dialog box.
Click the Ellipsoid button, and select the Ellipsoid: International
1924 .

•
•

Click OK in the Select Ellipsoid dialog box.

•
•

Click OK in the Select Datum dialog box.

Click the Datum button and select the Datum: Provisional South
American 1956 and select the Area: Bolivia .
If you now click the Ellipsoid button, you can see that the ellipsoid
International 1924 is used. Click Cancel in the Select Ellipsoid dialog box.

•

In the Coordinate System Projection “Cochabamba” dialog box, clear
the check box Northern Hemisphere and enter for the UTM Zone: 19

•
•
•

Type for Min X: 795000 and for Min Y: 8071500
Type for Max X: 808500 and for Max Y: 8090500
Click OK in the Coordinate System Projection dialog box.

Coordinate system Cochabamba is now created and you can proceed with the
digitizer installation and configuration.

3.1.2 Digitizer setup
To be able to digitize in ILWIS, a digitizer tablet and a digitizer cursor with a
minimum of 4 cursor buttons is needed. Before you can use a digitizer, it must be
properly installed and configured. The digitizer can be configured either by using a
WinTab driver or by using the Digitizer Setup Wizard.
Using WinTab
The digitizer manufacturer usually supplies a WinTab driver; otherwise it can be
downloaded from the Internet. Install the WinTab driver on your computer (see your
digitizer manual or WinTab documentation). It is advised to use a WinTab driver,
because WinTab makes it easier to set up your digitizer and the digitizer can be used
for other applications as well.
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To set up your digitizer using a WinTab driver choose for WinTab communication in
the Select Port page of the Digitizer Setup Wizard.
Using Digitizer Setup Wizard
Before setting up a digitizer with the Digitizer Setup Wizard, you first need to
configure the digitizer tablet according to the digitizer manual. You need to pay
special attention to: Run Mode, ASCII data format, Baud Rate, Number of Data
Bits, Parity, Resolution, and Data Rate.
For the configuration of the digitizer tablet itself, you must know whether you
configured 9600 or something else for Baud Rate, 7 or 8 for number of Data Bits,
1 or 2 for number of StopBits and whether you used Even , Odd , or None for
Parity.
After you configured the digitizer tablet, you can use the Digitizer Setup Wizard. In
the Digitizer Setup Wizard, you have to specify exactly the same settings as during
the configuration of the tablet itself. Then choose the ‘Automatic’ configuration.
When the configuration is OK, the last page of the Digitizer Setup Wizard (i.e.
Size, Resolution and Final Check) gives you the opportunity to check the correct
working of all buttons, correct increase of digitizer coordinates when moving the
digitizer cursor to the upper right corner, etc.

!

For more information see the ILWIS Help topics How to set up a digitizer and
start digitizing and Digitizer Setup Wizard.

3.1.3 Map referencing
A digitizer records the location of spatial features by means of digitizer coordinates.
To correctly register features in a map, the relationship between map and digitizer
coordinates needs to be established. A minimum of three control points and the
corresponding map coordinates should be specified by the user in order to calculate
the transformation between digitizer and map coordinates. Since both coordinate
systems are metric, an affine transformation is used.
With the map coordinates of the control points expressed as Xi,Y i and the digitizer
coordinates as Xdig,i, Ydig,i (Figure 3.2), the following formula for an affine
transformation is used to calculate the transformation coefficients:
Xi = a1,1 * Xdig,i + a1,2 * Ydig,i + b1
Yi = a2,1 * Xdig,i + a2,2 * Ydig,i + b2

where:
ai,j and bi are the affine transformation coefficients.
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Figure 3.2:

Referencing a map to a digitizer (simplified). Left: the digitizer contains an active
area. Only within that area, the horizontal and vertical wires inside the digitizer can
pick up a signal from the digitizer cursor (right).

To determine the six transformation coefficients, at least three coordinate pairs are
required. If three or more coordinate pairs are entered, the equations are complete and
the coefficients are calculated. Using the affine transformation, new sets of
coordinate pairs are calculated for the control points. The differences between the
actual and the calculated coordinates of the control points (the residuals), indicate
how well the control points have been digitized and entered. Errors in location or
typing result in large residuals.
To digitize a map, the coordinate system of the map must be referenced to that of the
digitizer. In this exercise the point map shown in Figure 3.3 will be referenced.

☞

•
•

Make a photocopy of Figure 3.3.

•

From the File menu of the Main window, select Map Reference.

Position this map in the center of your digitizer and fasten it to the digitizer
with tape. With some digitizers you can also place the paper under a plastic
cover, so that it remains fixed.

The first Map Referencing dialog box is opened. In this box you can select or create
a coordinate system, which stores the minimum and maximum X and Y coordinates
of the map, and optionally a projection for the map. The information is used to
describe how coordinates on the earth surface are related to corresponding
coordinates on the map.
The check boxes in the dialog box are used to select metric or geographic
coordinates. Note, if you choose geographic coordinates, a projection and associated
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parameters have to be defined. The information is needed for the transformation of
geographic coordinates to metric ones.

!
☞

You can use the Transform Coordinates operation, to check whether the transformation from metric to geographic coordinate system and vice versa is correct
(see also chapter 4, section Map projections).

•
•

Select Cochabamba in the list box Coordinate System.
Accept the defaults by clicking the OK button.

The second Map Referencing dialog box (Figure 3.4) and the Map Referencing
command box (Figure 3.4) are opened. The Map Referencing command box shows
the coordinates of the digitizer cursor location and contains the options: Digitize
Point, Next Point and Delete Point. The numbers (0, 1, 2, 3) refer to the digitizer
cursor buttons which are normally labeled 0, 1, 2, 3, or 1, 2, 3, 4, or A, B, C, D. The
commands in this window are used for digitizing control points and have the
following meaning:
- Button 0: To digitize a control point on the map.
- Button 1: To move to the next control point.
- Button 2: To delete the currently active control point.

☞

•

!
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Move your digitizer cursor over the digitizing table. When you do so, you
should see the coordinates change in the upper part of the Map Referencing
command box.

When you don’t see any coordinates in the Map Referencing command box, or
when the coordinates remain the same while you move the digitizer cursor over
the digitizer, your digitizer is not set-up properly. Check the digitizer installation
(See section 3.2.1 or refer to ILWIS Help, topic How to set up a digitizer and
start digitizing).
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Figure 3.3:
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Point map Mountain_top.
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Digitizing control points
You are now able to start digitizing control points. After digitizing a point, you need
to enter the corresponding metric or geographic coordinates in the Map Referencing
dialog box (Figure 3.4).
It is important that you do the following as precise as you can.

☞

•
•

Position the digitizer cursor at point A of the map and press the 0 button.

•
•

Position the digitizer cursor to point B and press the 0 button.

•
•
•
•

!

Make sure the mouse pointer is located in the first (left hand) coordinate text
box. Type 795000 for the X coordinate and press the Tab key. The mouse
pointer is now located in the right hand coordinate text box. Type 8071500
for the Y coordinate of the point.
Type 808500 for the X coordinate and 8071500 for the Y coordinate of the
point.
Move the digitizer cursor to point C and press the 0 button.
Type 808500 for the X coordinate and 8090500 for the Y coordinate of the
point.
Move the digitizer cursor to point D and press the 0 button.
Type 795000 for the X coordinate and 8090500 for the Y coordinate of the
point.

You can use Ctrl+C and Ctrl+V to copy and paste coordinate values.

The Map Referencing dialog box shows information such as:
- digitizer: Position of digitized control points in digitizer coordinates (mm).
- coordinates text boxes: Position of digitized control points in real world X and Y
coordinates. These are either metric (X,Y) or geographic (LatLon) coordinates,
depending on the type of coordinate system used (first Map Reference dialog box).
- diff X diff Y: The diff X and diff Y columns indicate deviations (in millimeters)
between the actual map coordinates and the calculated ones. A large deviation may
signify that the coordinate pairs were entered incorrectly. If less than three points
have been digitized, diff X and diff Y are 0 since no deviation can be calculated.
- Sigma: The value of Sigma (in millimeters) for the current data, indicates the
accuracy with which the control points have been digitized. If the value of sigma is
much larger than 1, this indicates that an error was made when digitizing the
points, or when entering the coordinates. Sigma is the standard deviation calculated
from the differences between the digitized and the calculated control points.
- Scale: The calculated scale in horizontal and vertical or X and Y axes assumes that
the entered coordinates are metric. It also takes into account the resolution of the
digitizer (lines/mm or lines/inch as specified in the digitizer configuration).
- Rotation: The rotation of the map coordinates (X and Y axes) relative to the
digitizer X and Y axes.
80
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- Transformation option buttons: The methods that can be used to calculate the
transformation between digitizer and real world coordinates. An Affine
transformation is a first order function requiring a minimum of three tie points. The
order of this transformation is sufficient to account for changes in scale on the X
and Y axes and for the map translation and rotation. The Conformal transformation
is also a first order function and needs a minimum of two tie-points. By selecting
the Conformal transformation, the program only accounts for scale differences in X
and Y axes and for map rotation. Although mathematically two or three tie points
are needed for the conformal or affine transformations, it is preferred to use at least
four tie points to derive a notion of accuracy.

Figure 3.4:

☞

The Map Referencing dialog box and the Map Reference command box (upper
left). The actual values displayed on your computer may be different from the ones
shown in the figure, depending on the type of digitizer you used, the precision (lines
per inch), and the accuracy with which you digitized the four points.

•

Accept the default Affine transformation and click the OK button if the
Sigma is less than 1.

•

If the Sigma is larger than 1, repeat entering the control points until the
sigma is less than 1 and then click the OK button.

The Map Referencing dialog box will be closed. The digitizer is now referenced to
the map. The map reference settings are stored and will remain unchanged until you
enter a new reference setting. If the position of the map on the digitizer has changed,
or if you start to digitize another map, it is necessary to reference the map again.
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You are now ready to actually create a map and digitize the data that should be in the
map.

!

When you digitize paper maps that are quite old, or that have been exposed to
sunlight, the paper may not contain the same scale in X and Y direction, due to
shrinking. In such a case you will also not reach a sigma that is around 1, and you
either have to get a better paper copy to digitize, or accept that it is less accurate.
When producing a map from image interpretation that is to be used for digitizing,
it is therefore recommended, not to use paper, but a transparent film type that will
not shrink.

Summary: Map referencing
- A digitizer records the coordinates of spatial features by means of digitizer
coordinates. The relationship between the map and digitizer coordinate is
established by referencing the coordinates of the map to that of the digitizer.
- A minimum of three control points and the corresponding map coordinates are
required to reference the map. The map reference settings are stored and will
remain unchanged until you enter new reference settings.
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3.2 Digitizing a point map
In this exercise a point map called Mountain_top will be created. The points in the
map show the peaks of mountains and hills in the Cochabamba area, Bolivia. A hardcopy of the map is presented in Figure 3.3. A photocopy of the same map was used in
the previous exercise for map referencing.

!
☞

It is assumed that the photocopy of Figure 3.3 is still attached in the same position
on your digitizer table. If you removed the map, you will have to repeat the map
referencing (explained in the previous exercise), since the position of the control
points on the digitizer may have changed.

•

In the Operation-tree in the Main window, expand the Create item and
double-click New Point Map. The Create Point Map dialog box is opened.

•
•
•

Type Mountain_top in the Map Name text box.

•

Click the Create button next to the Domain list box. The Create Domain
dialog box is opened.

Type for the Description: Points indicating mountaintops .
Select the Coordinate System: Cochabamba . This is the coordinate system
that you have created in the previous exercise. Note that the display of the
minimum and maximum X and Y coordinates changes, as the values of the
coordinate system are used.

As explained in the previous chapter, service objects such as a domain and a
coordinate system, are needed to create a map (data object). A list of IDs or classes,
or the value ranges and the precision used to codify elements in a map, are defined in
a Domain. The domain contains all possible names or values that may occur in a
map. See also chapter 2 for more information about domains.

☞

•
•

Type Mountain_top in the text box Domain Name.
Select the option Identifier .

The domain type identifier (ID) is selected for this point map, because each point in
the map is identified by a unique number. Selecting the domain type identifier, a text
box with the default value 0 appears. Optionally, you can use the text box to define
the number of items in the domain. It is then also possible to give each item a prefix
(e.g. nr , or point ).

☞

•

Accept the default for the Nr of items and click OK.
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The Domain Identifier editor is opened. The editor can be used to add, change or
delete items in the domain. When you digitize you can either:
- First describe all domain items before you digitize, or;
- Define the domain items while you digitize.
The point IDs will be entered during digitizing.

☞

•

Close the Domain Identifier editor. You are now back in the Create Point
Map dialog box. Note that the domain Mountain_top , which you just
created, is indicated in the list box Domain.

•

Click OK in the Create Point Map dialog box.

The Point editor and the Point editor command box are opened (Figure 3.5).

Figure 3.5:

The Point editor and the Point editor command box.

The Point editor command box shows the position of the digitizer cursor and
consists of the following commands:
- Button 0: Add Point: For digitizing a new point.
- Button 1: Move Point: Allows you to move a point.
- Button 2: Change Window: For changing the window displayed on the screen.
- Button 3: Edit Point: For editing the label of a point.
The following buttons on the Toolbar of the Point editor window are shortcuts to
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select different modes, manage your data and to exit the editor:
Select Mode: this allows selection of one or more existing features (points,
segments, polygons or pixels) with the mouse. When you click the Select Mode
button the mouse cursor appears as a hand. In this mode you can select a feature
by clicking it.
Move Points Mode: this allows you to select a point (or a point within a

segment) with the mouse and drag it to a new position. When you click the Move
Point Mode button, the mouse pointer appears as a pair of tweezers.
Insert Mode: this allows you to insert new features with the mouse. When in the
Insert Mode, the mouse cursor appears like a pencil.
Undo All Changes button: to undo all changes since you last used the Save
button. If you haven’t used the Save button sofar, the original map will be

restored.
Save button: to save your map to disk.
Exit Editor button: used to exit the editor.

The Point editor works in the Select, Move Points and Insert Modes.
You can work with the Point editor by using the mouse or the digitizer apart or
simultaneously.
Digitizing points
In this exercise you will digitize new points using the digitizer cursor.

☞

•
•

Position the digitizer cursor at point 1 and press button 0 (Add Point).

•

Digitize the rest of the points (Figure 3.3) and label them as follows:

A small box is opened at the digitized point. Type P1 in this box and press
Enter ↵.

Table 3.1: The codes used for digitizing the points in Figure 3.3.
Point #

Point label

Point #

Point label

Point #

Point label

1
2
3
4
5

P1
P2
P3
P4
P5

6
7
8
9
10

P6
P7
P8
P9
P10

11
12
13
14
15

P11
P12
P13
P14
P14

When you enter the label P14 for point 15, a message appears indicating that the
label P14 is used for another point. Although the ID domain allows duplicate names,
it is not very logical to have two points in an ID domain with the same name. To
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enter the correct label for this point:

☞

•
•

!

Click No in this box and enter a new name for this point.
Type P15 and press Enter ↵.

It is recommended to save your work regularly during the digitizing process: you
can either use the Save button or the Save command on the File menu. When
you leave the editor using the Exit Editor button, your work is saved automatically.

Editing a point
The label (ID) of a point can be edited or changed if incorrectly entered. To edit or
change the label of a point:

☞

•

Position the digitizer cursor at the point which has to be edited, in this case
point 15 and press button 3. Type a new label for this point, e.g., P16 and
press Enter ↵.

Moving a point
A point can be moved either by choosing the Move Points Mode in the Toolbar or
by using the digitizer cursor:

☞

•

Position the digitizer cursor at the point which has to be moved, in this case
point 14 and press button 1. The digitizer cursor on your screen changes
from an x to a +.

The Move Point command box (Figure 3.6) is shown. It has the following options:
- Button 0: New Position: Specifies the new position for the selected point.
- Button 1: No function.
- Button 2: Change Window: Changes the window displayed on the screen.
- Button 3: Return: Returns to the Point editor command box.

Figure 3.6:
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The Move Point command box.
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☞

•

Move the cursor about a centimeter above the point 14 and press button 0.

If during digitizing points were incorrectly entered, they can be repositioned
afterwards.
Deleting a point

☞

•
•
•

In the Toolbar, choose with the mouse the Select Mode button

•

Click Yes in the opened Point Editor message box to confirm.

.

Put the mouse pointer on point 16 and select it.
Press the right mouse button to open the context-sensitive menu and select
Delete. You can also press the Delete key on the keyboard.

Multiple points can be selected by pressing the Shift, or the Ctrl key while you select
more points. The digitizing of points is now finished, so you can exit the Point editor.

☞

•
•

Click the Exit Editor button

in the Toolbar.

Close the map window.
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3.3 Digitizing a segment map
Before you continue to digitize a segment map, it may be good to explain first about
how points, segments and polygons are digitized. Points, segments and polygons are
three types of spatial features used in ILWIS. An individual point is defined by a pair
of X and Y coordinates. A segment is composed of a series of intermediate points,
connected by straight lines, with a start and an end node. A polygon is a closed area
consisting of one or more segments. All segments forming a polygon have to be
connected at intersections. Each intersection or end connection of segments has a
node (Figure 3.7).

Figure 3.7:

Presentation of points, segments and polygons in ILWIS.

When you digitize a polygon, the boundary lines of this polygon should be
connected. The connection of one line to another is called snapping. Snapping always
takes place at a node (the end of a line). Snapping is needed for polygons, and for
segment maps that represent a network (e.g. a drainage network, or a road network).
Snapping is not required for other segment maps, such as a contour map. When you
digitize a contour map, you can only snap lines that have equal altitude.
You can digitize a line, by holding down the cursor button and simultaneously
moving the cursor on the line (digitizing in stream mode). The line coordinates are
recorded at regular time intervals. The disadvantage is that many points are needed to
define the segment. Many of these points do not improve the accuracy of the line and
are considered redundant.
You can also digitize a line, by pressing the cursor button only when a point in the
segment needs to be digitized (digitizing in point mode). In this way coordinates are
only recorded if the button is pressed. The number of points used to store a segment
depends on the complexity of the line, and on the accuracy of the person digitizing.
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To reduce the number of coordinates defining a segment, a data reduction procedure
called tunneling is carried out automatically (Figure 3.8). The necessity of each
coordinate, is evaluated by connecting the adjacent coordinates by a line or tunnel
with a pre-defined width. When the evaluated coordinate lies inside the tunnel, it is
considered redundant, and is removed. If it lies outside the tunnel, it is kept and the
same operation is carried out for the next coordinate.

Figure 3.8:

The process of tunneling using two different tunnel widths. See text for explanation.

In this exercise, a segment map which contains information about the road network in
the area will be created. This segment map is presented in Figure 3.9.

☞

•
•

Make a photocopy of Figure 3.9.

•

From the File menu of the Main window, select Map Reference. The first
Map Reference dialog box is opened.

Remove the photocopy of Figure 3.3 if it is still on the digitizer. Position the
photocopy of Figure 3.9 in the center of your digitizer, and fasten it to the
digitizer with tape. With some digitizers you can also place the paper under a
plastic cover, so that it remains fixed.

When a new map is placed on the digitizer, or when you have moved the map that
you were digitizing before, you will have to reference the map again. However, the
Map Reference dialog box still contains the X and Y values of the control points of
the previous map. So if the new map uses the same control points, the only thing to
do is to digitize the four points. Once a map is referenced, it remains like that, until
you make a new map reference. So even if you turn off the computer and when later
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on you decide to continue digitizing, and the map on the digitizer is still in the same
position, you don’t have to reference your map anymore.

☞

•

Accept the defaults by clicking the OK button. The second Map
Referencing dialog box and Map Referencing command box (Figure 3.4)
are opened.

•

Digitize the four control points of Figure 3.9. Make sure to digitize the correct points for the XY coordinates that are already given in the Map
Reference dialog box. Click OK when the error is tolerable (Sigma value is
around 1 or lower). Otherwise digitize the four points again.

•

From the File menu of the Main window, select Create, Segment Map. The
Create Segment Map dialog box is opened.

•
•
•

Type Road in the text box Map Name.

•

Type Road in the text box Domain Name, make sure the option Class is
selected as the domain type and click OK. The Domain Class editor is
opened.

Select Cochabamba from the list box Coordinate System.
Click the Create Domain icon in the list box Domain. The Create Domain
window is opened.

It is possible to write the names of the domain items in the Domain Class editor
directly. In this exercise, however, you will create the names during digitizing.

☞

•

Close the Domain Class editor. You are back in the Create Segment Map
dialog box.

•

Click OK in the Create Segment Map dialog box.

The Segment editor and the Add Segments command box are opened. The
Segment editor works in Select Mode, Move Points Mode, Split/Merge Mode
and Insert Mode.
Split/Merge Mode: This is only used in the Segment editor. It allows the

splitting of segments and the creation of a node. It also allows the removal of
unnecessary nodes. When you click this button the mouse pointer changes to a
pair of scissors.
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LEGEND
Segments EF, PQ, HR and RNO
Segments LFMN, MGH, HID and ISQ
Segments KLG, CS and TCD
Segments MU, DJ and IR
Figure 3.9:
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= highway
= main road
= motorway
= earth road

The segment map road (not according to the real situation). The nodes of each line
have a code in this example to facilitate the explanation on how to digitize.
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The Add Segments command window shows the position of the digitizer cursor and
the commands. The commands in this window are:
- Button 0: Begin Segment. To start digitizing a new segment, with its starting
point not connected to another segment.
- Button 1: Snap Segment. To start digitizing a new segment, with its starting
point connected to another segment: snapping.
- Button 2: Change Window. To change the area of digitizing displayed on the
screen (zoom in or zoom out).
- Button 3: Move Points. To switch to Move Point Mode.

☞

•

Move the digitizer cursor away from the part of the digitizer covered by the
map. You will hear a beeping sound. This is to remind you that the digitizer
cursor is outside of the georeferenced area.

•

Move the digitizer cursor back inside the part of the digitizer covered by the
map. The sound stops.

Zooming in
Before you start digitizing a part of the map, we recommend you to zoom in on that
area, so that you can digitize as detailed as possible. This is especially important
when you are going to connect segments.

☞

•

Press digitizer button 2 (Change Window). Now the Change Window
command box appears.

•

Position the digitizer cursor on the upper left corner of the box indicated in
Figure 3.9 with a hatched line. Press digitizer button 1 (1st Point).

•

Move the digitizer to the lower right corner of the box with a hatched line
and press digitizer button 2 (2nd point). The map window now only displays
the area inside the box. Check this by moving your digitizer cursor through
the box.

Note that you can use button 0 (Entire Map) to zoom out again. You can also zoom
in by using the mouse pointer. In that case, click the Zoom In button on the Toolbar
of the Segment editor and define the area you want to zoom in.
Digitizing segments
In Figure 3.9 each node has a code. This is only used here so that we can explain
better how to digitize. To digitize the segment QHISQ:
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•

Click the Maximize button
window.

•
•

Position the digitizer cursor at point Q in the map.

with the mouse pointer to enlarge the map

Press digitizer button 0 to enter the point (starting point of the segment).
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The program proceeds to the command box Digitize Segment (Figure 3.10A). In
this box:
- Button 0: Enter Point. To enter the (intermediate) points of the segment.
- Button 1: Snap End Segment. To end a segment by connecting it to another or
by creating a closed segment: Snapping.
- Button 2: End Segment. To end the segment, not connected to another segment.
- Button 3: Delete Last Point. To delete wrongly digitized point(s) at the end of
the segment.

(A)

(B)

Figure 3.10: The Digitize Segment command box (A), and the End Segment command box (B).

☞

•

Move the digitizer cursor along the line QHISQ while holding down the button 0 of the digitizer cursor.

Note, since the button 0 is continuously pressed the coordinates are recorded at
regular time intervals (see section 3.2). This is digitizing in stream mode.

☞

•

Release the button 0 when you are just before the starting point Q of the line
QHISQ .

It is important to stop digitizing a little bit before you reach the actual point where
you want to connect the segment. This is done to ensure that no additional
intermediate coordinate is digitized, which is in fact on the other side of the
connection point, and which will cause an error when you check the segments later.

☞

•

Move the digitizer cursor to point Q while not holding down the button 0 of
the digitizer cursor.

•

Press button 1 (Snap Segment).

The snap segment ensures that the segment is linked to the starting node. The
program proceeds with the End Segment command box (Figure 3.10B). In this box,
you can select:
- Button 0: Accept. To accept the point to which the segment will be snapped.
- Button 1: Snap Other. To select another node, within the snap tolerance, to snap
the segment to.
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- Button 2: Snap Split. To split the selected segment into two and to snap the
segment to the two new segments.
- Button 3: No Snapping. To return to the Digitize Segment command box.

☞

•

Press the 0 button to snap the last point to the starting point.

The Edit dialog box is opened. In this box you can select one of the existing classes
or new to enter a new name for the digitized segment or for the segment which will
be digitized. In this exercise, the domain does not yet contain any class. Therefore,
you have to select <new> in order to enter a label for the digitized segment.

☞

•

Select <new> from the list box Class Name.

The Add item to Domain dialog box is opened. Here a Name, a Code and a Color
for the digitized segment can be entered.

☞

•
•
•
•

!

Type Main road in the text box Name.
Type Mr in the text box Code.
Select a color in the list box Color. This color will only be shown after you
leave the editor.
Click OK in the Add item to Domain dialog box and in the Edit dialog box.

It is advised to enter codes (letters or numbers), especially, when the class names
are long and you intend to use the map for further MapCalc operations. The
codes can be used in the map calculation formula instead of the class names.

The Segment editor will by default display all segments in the same color (default
Green). If during digitizing you want to check on segment names/codes and have the
segments drawn in the color of the representation, open the Customize Segment
Editor dialog box (File, Customize) and select Segment colors Domain .
The lines EF , PQ , HR and RNO represent highways in the map. Before digitizing the
lines, we will add a new class Highway to the domain. To add a new class:

☞
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•

From the Edit menu of the Segment editor, select Insert Code. The Edit
dialog box is opened.

•

Select <new> from the list box Class Name. The Add item to Domain dialog box is opened.

•

Type Highway in the text box Name and Hw in the text box Code.

➥
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➦

•

Select a color in the list box Color and click OK in the Add item to
Domain dialog box. You are back in the Edit dialog box.

•

Click OK in the Edit dialog box.

Now you can also digitize the lines representing highways. It is advised to save your
work regularly.

☞

•

Zoom in on the lower half of the map between point E and the lower right
corner of the map.

•
•
•

Position the digitizer cursor at point E and press the 0 button.

•

Digitize segment PQ . To end segment PQ at Q, press digitizer button 1 (Snap
End Segment) and then button 0 (Accept). In this way node Q connects
segments QHIS and PQ .

•

Digitize segment HRNO similarly. To start segment HRNO at H, press respectively digitizer button 1 (Snap Segment), button 2 (Snap Split) and button
0 (Accept). In this way node H connects segments HISQ and HRNO . Move
the cursor while pressing button 0. End the segment by pressing button 1
(End Segment).

•

Also digitize segments KLG and TCD . You will edit the codes of the segments
later.

Keep pressing this button and move the cursor along the line EF .
Release the button when the cursor is at point F and press the 2 button (End
Segment).

Now, if you want to digitize segment CS , there is a problem. Since there is no node
yet at point C, the segment TCD should be split first before you can digitize segment
CS . You can split a segment during digitizing, as you did before, but now we will use
the Split/Merge Mode.

☞

•

Click the Split/Merge button on the Toolbar. The mouse pointer changes to
a pair of scissors.

•

Position the mouse pointer at point C (check with digitizer cursor) and click
with the mouse. The following message is shown:

•
•
•

Split Segment hw: Highway ?

Click Yes. The segment is now split and an intermediate node is shown.
Click the newly created node. The message appears:
Merge segment hi: Highway with hw: Highway? Click No.

With the Split/Merge Mode you can split segments into two, connected by a node.
You can also use it to remove unnecessary nodes.
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☞

•
•
•
•

•
•

Position the digitizer cursor at point C and press button 1 (Snap Segment).
Press digitizer button 0 (Accept).
Press digitizer button 0 and move along the line CS until you are near to S.
Position the mouse pointer on point S and press digitizer button 1 (snap end
segment). With a sound it is indicated that the segment cannot be connected
to point C, since there is no node yet. The End Segment command box
appears.
Press digitizer button 2 (Snap Split) to split the segment QHISQ .
Press digitizer button 0 (Accept) to accept the location where the segment
QHISQ will be split and where the segment CS will be connected.

The previously digitized segments KLG , CS , TC and CD were coded as Highway, but
in fact they represent Motorways . Since no new class name has been defined for
them yet, they automatically got the same class name (Highway ) as the last digitized
segment. Hence, the names of the segments need to be changed to Motorway . You
will use the mouse to change the class names of these segments.

☞

•
•
•

Press the Select Mode button on the Toolbar with the mouse pointer.

•

Do the same for the segments TC and CD . Note that TCD now consists of two
segments, since you have split it.

•

Click the right mouse button, to open the context-sensitive menu and select
Edit. The Edit dialog box is opened.

•

Select <new> in the Edit dialog box. The Add item to Domain dialog box
is opened.

•

Type Motorway in the text box Name, type Mw in the text box Code, select
a color in the list box Color and click OK.

•

Click OK in the Edit dialog box.

Position the mouse pointer on the segment KLG and select it.
Press the Shift key and put the mouse pointer on the segment CS and select
it. In this way you can select multiple segments.

The names of the segments can also be changed by double-clicking the segment.

☞

•
•

Double-click the segment KLG .
The list of the existing segment labels is displayed, and you can see that the
selected name for segment KLG is Motorway .

As you have seen, the connection of one segment to another is done via snapping.
This is to ensure that the segments are linked precisely through the nodes. Snapping
only succeeds if a point exists within the snapping tolerance distance. A beep warns if
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this is not the case. Reposition the cursor near the point you want to snap and try
again. The snap command only functions when you snap to the starting or ending
point of a segment. To snap to an intermediate point, the segment has to be split and
then snapped. The snap tolerance is a distance within which the program will accept
a node to snap to it. You can define the snap tolerance yourself in the Customize
Segment Editor dialog box.

☞

•

From the File menu of the map window, select Customize. The Customize
Segment Editor dialog box is opened.

Within the Customize Segment Editor dialog box you can see that the default
value for the Snap tolerance is 190 meters. This means that if you want to connect
two segments, and the cursor is less than 190 meters from a node, this node will be
used to connect the two segments. The snap tolerance is defined by the system when
you start the Segment editor, based on the coordinate boundaries (and the scale) of
your map. The user may enter another value if needed. A large value for the snap
tolerance will make the map less accurate. A very small value for the snap tolerance
will make the digitizing difficult, since you have to zoom in a lot before you can
snap. When you work with the mouse, the option Snap tolerance (pixels) is used.
The default value is 5 pixels.
Note also another value in the Customize Segment Editor: The Tunnel tolerance.
This value (in this case 19 meters) defines the width of corridor between the first and
last of three points (see Figure 3.8). If the second point falls within this corridor, it
will not be used as intermediate point, and therefore not stored. If it falls outside the
corridor, it will be used as intermediate point. So by selecting the tunnel tolerance
you can influence the detail of the lines that you digitize. If you increase the tunnel
tolerance, the segments will be digitized rather coarsely, with only a few intermediate
points. If you make the tunnel tolerance very small, many intermediate points will be
stored and the size of your segment map will become large.
Note also that the default setting for Auto Snap in the Customize Segment Editor
is selected. This means that when you end a segment with the mouse, the system will
automatically try to snap it.
Now you will practice some more with snapping segments.

☞

•
•

Click Cancel in the Customize Segment Editor dialog box.

•
•

Digitize segment FL by pressing the button 0. Stop just before L.

Put the digitizer cursor at point F and press the button 1, to snap the starting
point of the new segment to point F of the segment EF and press button 0 to
accept.
Press button 1 to snap this segment to point L of segment KLG . The program
proceeds to End Segment command box.
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➦

•

Press button 2 (Snap Split) to split the segment KLG to segments: KL and
LG.

•
•
•
•

Press button 0 to snap the segment FL to one of the segments (KL or LG ).
Double-click FL . The Edit dialog box appears.
In the Edit dialog box select Mr: Main road and click OK.
Digitize the rest of the segments yourself, and use snap or split where necessary. To codify the segments, follow the legend of Figure 3.9.

Change the position of a point
An incorrectly digitized point can be corrected by re-positioning it afterwards.
Assume that the correct position of point V on the line UM (Figure 3.9) is at point Z.
To change the position of this point:

☞

•

Return to the Add Segment command box. Press button 3 to select the
Move Point Mode.

The program proceeds to the Move Points command box. In the Move Points
Mode, all segment nodes appear as little boxes and all intermediate coordinate pairs
appear as small crosses.
The Move Points Mode can also be selected from the Edit menu or from the
Toolbar of the Segment editor.
The commands in the Move Points command box (Figure 3.11A) are:
- Button 0: No function.
- Button 1: Take Point. To select a point to be moved.
- Button 2: Change Window. To change the window displayed on the screen.
- Button 3: Return. To return to the Add Segments command box.

☞

•
•

Zoom in on the area surrounding point V.
Position the digitizer cursor (box) on an intermediate point near point V and
press button 1.

The program proceeds to the Retouch Point command box (Figure 3.11B). The
commands in this command box are:
- Button 0: New Position. To drop the point at a new position.
- Button 1: Take Point. To select another point to be moved.
- Button 2: Snap. To drop the point at an existing node (snap) or to drop the point
on an existing segment to a point on the segment on which it has been positioned.
- Button 3: Return. Return to the Move Points command box.
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(A)

(B)

Figure 3.11: The Move Points (A) and Retouch Point (B) command boxes.

☞

•

Position the cursor at the new position, point Z and press button 0.

You can also use Move Points Mode to correctly snap nodes, for example the end
point of segment EF .

☞

•
•

Zoom in on the area around node F.

•
•

Press digitizer button 1 until the line EF is shown in red.

Put the cursor at node F, and press button 1. The Retouch Points command
box is opened.
To connect it to another segment, press button 2.

Deleting a segment
Incorrectly digitized segments can be deleted with the mouse. Suppose the segment
UM was incorrectly digitized, and you want to delete it:

☞

•
•
•

Zoom in on the area of segment UM .
Choose with the mouse pointer the Select Mode. Select segment UM .
Click with the right mouse button and select Delete from the context-sensitive menu.

Deleted segments can be undeleted. If the segment UM was deleted by mistake and
you want to undelete it:

☞

•

Open the context-sensitive menu and select Undelete segments. The deleted segments will be displayed in the map window with a different color.

•

Select the undeleted segment MU to really recover the segment.

Deleted segments, which can be undeleted, are shown in a color specified in the
Customize Segment Editor dialog box.
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Displaying segments in different colors
You can quickly see how many classes exist in a segment map, by displaying the
segments in different colors or in the colors defined in a representation.

☞

•

Open the context-sensitive menu in the map window by clicking the right
mouse button, and select Customize. The Customize Segment Editor dialog box is opened.

From this box you can choose to display the segments in Normal color, colors
defined in the representation (Domain), or in Primary Colors.

☞

•
•
•

Select Domain from this box and click OK.
Click the Exit Editor button. The segment map is displayed.
Close the map window after you have seen the result.

The final part of segment digitizing is the checking of the segments. The items that
are checked are intersections of lines without a node, dead ends in segments, self
overlapping segments and consistency of the codes.
The checking of segments is not treated here. In section 3.5, a detailed explanation
will be given of the procedure for checking segments and correcting errors.
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3.4 Digitizing contour lines
In the previous exercise you have seen how to digitize a segment map with a class
domain. Now you will learn how to digitize segments (contour lines) with a value
domain. Each contour line is digitized with the corresponding height as the value.
The contour value is given in the map (Figure 3.12). This contour map can be used to
create a Digital Elevation Model (see chapter 10). Digitizing contour lines is quite a
tedious job. To simplify the exercise, only the southern part the contour map of the
study area will be digitized. When digitizing, take the following into consideration:
- Always digitize contour lines a little bit further outside the boundaries of the study
area, to prevent the boundaries of the area having wrong results after contour
interpolation.
- Where many contour lines are close to each other, it is preferred to digitize only a
few to minimize errors in the interpolation.
- To prevent hills having a flat top, hilltops should be digitized as small lines,
defined by the highest closed contour line, or as a point map in a separate file.

☞

•
•

Make a photocopy of Figure 3.12.

•

From the File menu of the Main window, select Map Reference. The Map
Reference dialog box is opened.

•

Reference the map (Figure 3.12) to the digitizer, similarly, as described in
section 3.1.3. Mind: the minimum and maximum X and Y values are different for this map.

•

Expand the Create item in the Operation-tree and double-click New
Segment Map. The Create Segment Map dialog box is opened.

•
•
•

Type Isolines for the name of the map.

•
•
•

Click the Create Domain button. The Create Domain dialog box appears.

•

Close the Create Domain dialog box by clicking OK. You are now back in
the Create Segment Map dialog box. Click OK.

Remove the photocopy of Figure 3.9 if it is still on the digitizer, position the
photocopy of Figure 3.12 in the center of your digitizer, and fasten it to the
digitizer.

Select Cochabamba from the list box Coordinate System.
Change the Min X and Y values in 800900 and 8071400 respectively and
the Max X and Y values in 808300 and 8080100 . By making the minimum
X and Y values a bit lower (100 m) and the maximum ones a bit higher (100
m), you can digitize the contour lines a little bit outside the map boundaries.
Type Isolines for the Domain Name and select domain Type Value .
Type 2000 and 4000 in the Min, Max text boxes, and type 0.1 in the text
box Precision.

The Segment editor and the Add Segments command box are opened.
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☞

•
•
•

From the Edit menu of the segment editor, select Insert Code.
The Edit dialog box is opened.
Type the value: 2560 . This will be the default value for all segments that you
will digitize from now on. Click OK.

•

Digitize the contour lines with the altitude 2560. After you finished digitizing each line, click OK in the Edit dialog box.

•

Subsequently digitize a first contour line of altitude 2580. In the Edit dialog
box, which appears after you finished digitizing the line, change the value
into 2580 and click OK.

•
•
•
•

Digitize the other two contour lines with this altitude.
Continue to digitize the rest of the contour lines.
Make sure to snap different parts of the same contour line.
Do not digitize the boundary.

When you finish digitizing the contours, you can easily check whether an error
was made, by checking the code consistency. The code consistency check finds
segments that are connected, but have different values. This cannot be true for
contour lines.

☞

•

From the File menu of the segment editor, select Check Segments, Code
Consistency.

•

Accept the defaults in the Check Segments dialog box and click OK. If the
program finds an error, it will indicate the place of the error with a red box
and a dialog box appears stating the nature of the error: Different codes
‘value’ and ‘value’ at node. Zoom in on error?
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•

Click Yes to zoom in and correct the errors (if any) by recoding the wrong
segments.

•

Press the Exit Editor button when the digitizing is finished. When the
segment editor is closed, the segments are displayed in a map window;
segments are displayed with system representation Pseudo .

•

Close the map window when you have seen the result.
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Figure 3.12: The segment map Isolines.
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3.5 Creating a polygon map
Now you will see how to digitize a polygon map. A polygon map can be created
using the following steps:
- Digitizing the boundaries of the polygons as segments in the Segment editor;
- Checking the segments in the Segment editor;
- Digitizing the labels of the polygons as a point map in the Point editor;
- Polygonizing the segments using the point map as labels in the Segment editor.
The digitizing of segments is not treated here anymore. This was already explained in
section 3.3. You will start this exercise with a segment map that contains a number of
errors, which will be detected and corrected during the checking of the segments.
The file with which you will work is named Checkseg . It is the digital version of
Figure 3.14. It contains segments with the code Unitbound .

☞

•
•
•

Make a photocopy of Figure 3.15 and fix this to the digitizer.
Reference this map with the method explained in section 3.1.3.
In the Catalog, click segment map Checkseg with the right mouse button
and select Edit from the context-sensitive menu.

The Segment editor and the Add Segments command box are opened.
Checking segments
After you finished digitizing segments, you should check whether all segments are
correct. The most important errors that may occur during digitizing are shown in
Figure 3.13:

Figure 3.13: Different types of digitizing errors that are detected during the checking of seg-

ments. See text for explanation.
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- Dead end in segment. The segment is not connected to another segment. This is
shown in example 1.
- Intersection without node. The segment overlays another segment without a node.
Several examples are shown in 2 and 3.
- The same segment is digitized twice. This may happen in large files, or in files you
obtain from someone else. This is illustrated in example 4.
- Self Overlap. The segment crosses itself. This is shown in example 5.
Before a map can be polygonized, it should be checked whether the segments have
been digitized and snapped in a proper way. This check is done using the option
Check Segments from the File menu of the Segment editor map window. You can
make corrections either with the digitizer cursor or with the mouse pointer. Segments
can also be checked when you select the option Polygonize from the File menu.

☞

•

From the File menu of the editor window, select Check Segment and Self
Overlap. The Check Segments dialog box is opened.

•

Accept the defaults and click OK. The map is now checked for segments that
overlap themselves. The program checks and a Check Segments message
box with the question Zoom in on error? appears.

•

Click Yes to automatically zoom in on the part where the error occurs. This
is near D in the map and the error is indicated with a red box.

The situation near point D is shown in Figure 3.14A. As you can see the segment
crosses itself. To correct it automatically, there are two possibilities:
- Remove the false polygon (shown in Figure 3.14B).
- Split the segment (shown in Figure 3.14C).

Figure 3.14: Self overlap error near point D in Figure 3.15. A: Original situation showing the

overlap. B: Situation after automatically removal of false polygon. C: Situation after
automatic splitting segments.
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Figure 3.15: Polygon map Geomorphology.
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☞

•

The program will give an error message: Segment unitbound (nr 4) crosses itself. Remove false polygon?

•

Click Yes. The false polygon is removed and the program will continue to
check for other segments that overlap themselves. It will give again the message Zoom in on error?

•

Drag the Check Segments message box outside the map window and compare the segment map near point D with Figure 3.14B. Then click Yes in the
message box to zoom in on the area near M. The message Segment unitbound (nr 21) crosses itself. Remove false polygon? appears.

•
•

Click No. The message Split Segment unitbound appears.
Click Yes. A node is inserted at the intersection and a new small polygon
now remains near M. The situation is comparable with the one shown in
Figure 3.14C. We will delete this small polygon later by hand.

It is in general not advisable to use the automatic editing options (such as Remove
false polygon, or Split Segment), since this may lead to many small polygons (if
you use the Split Segment option), or to unwanted generalization of the segment (if
you use the Remove false polygon option). Instead it is often better to edit the error
manually using the Move Point Mode.

☞

•

The program is now checking further on segments that overlap themselves
and will give again the message Zoom in on error?

•

Click Yes to zoom in on the area with the red box (between M and L). An
error message Segment unitbound (nr 25) crosses itself. Remove false
polygon? is shown.

•
•

Click Cancel.

•

Click the Move Points button
and use the mouse pointer, which is now
in the form of little tweezers, to move the intermediate points of the segment,
until they no longer overlap.

•
•

Click the Select Mode button and the Entire Map button when finished.

Press the Zoom In button on the Toolbar and zoom in on the lower part of
the lake between M and L.

From the File menu in the Segment editor, select Check Segments, Self
Overlap. The Check Segments dialog box is opened.

•

Select the check box Start at Number. The number of the last checked segment is shown.

•

Click OK. The checking is resumed and, if you made the corrections well, no
other self overlapping segments are found and the Segment Editor message
OK: Segments are not overlapping themselves appears.

•

Click OK to close the message box.
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The next check that will be made is on dead ends in segments (see Figure 3.13
example 1).

☞

•

From the File menu in the Segment editor, select Check Segments and
Dead Ends. The Check Segments dialog box is opened.

•

Click OK. The map is now checked for segments that are not connected to
others (dead ends). An error message will appear: Dead end in Segment
unitbound (nr 14). Zoom in on error?

•

Click Yes to zoom in on the area around H. The situation near H is shown in
Figure 3.16.

Figure 3.16: Dead ends in segments, near H in the map of Figure 3.15.

As you can see there are three segments at point H which are not properly connected.

☞

•

Use the mouse pointer to move the nodes of the segments until they connect.
Return to Select Mode and click the Entire map button when finished.

•

From the File menu of the Segment editor, select Check Segments, Dead
Ends. The Check Segments dialog box is opened.

•

Select the option Start at Number and click OK. The checking is resumed.
Again an error message will appear, now near point J.

•

Correct the error at point J and resume checking dead ends. You may need to
extend the map window (via the Options menu) a bit on the left (e.g. 10%).
There will be another error at point D. Continue checking dead ends until no
more error messages appear.

The last check that will be made is on intersections without nodes (see Figure 3.13
examples 2 and 3).
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☞

•
•

Display the entire map.

•

Click OK. The map is now checked for segments that are intersecting without
a node. The message Zoom in on error? appears.

•

Click Yes to zoom in on a location near E. The situation near E is shown in
Figure 3.17A.

From the File menu of the Segment editor, select Check Segments and
Intersections. The Check Segments dialog box is opened.

Figure 3.17: Intersection without node near point E in Figure 3.15.

A: Original situation. B: Situation after automatic correction.

☞

•

Another error message Intersection without node in Segment unitbound
(nr 6). Split segment? appears.

•

Click Yes.

The situation near point E after automatic correction is shown in Figure 3.17 B. As
you can see, it is not always advisable to use the automatic editing option since this
may lead to many small polygons. Instead it is often better to edit the error manually
using the Move Point Mode. You will now correct the error near L manually using
the Move Points Mode.

☞

•

The program resumes checking intersections and will display an error message for an error near L (after you clicked Yes in the Zoom in on error message box). Do not accept automatic correction and select No.

•

Use the mouse pointer to move the nodes of the segments so that the two
segments no longer intersect. Click the Entire Map button when finished.

•

From the File menu in the map window, select Check Segments and
Intersections. The Check Segments dialog box is opened.
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➦

•

Select the option Start at Number and click OK. If you corrected the previous errors well, no more errors are found.

There is one more option to check segments: Code Consistency. This is useful only
in situations where you want only segments with the same code to be connected. For
example, in the case of contour lines, where only lines with the same altitude code
should be connected. In the example of the segment map Checkseg this is not a
useful option, since there is only one segment code (Unitbound ).
To better see the effect of automatic editing, you will now correct for the small
polygons that were generated during the automatic editing in point M and point E. You
will do this with the mouse pointer.

☞

•
•

Zoom in on the area around M.

•

Repeat the procedure for the area around point E and click the Save button
when you are finished with the exercise.

•

Exit the Segment editor by pressing the Exit Editor button
return to a map window displaying the correct segments.

Choose the Select Mode, select the small unwanted segments and delete
them by pressing Delete.

. You will

The segments of segment map Checkseg are now error free, and you can proceed
with the creation of the polygon map.
Creating a label point file
When you create a polygon map, the best procedure is to digitize the boundary lines
of the segments in a segment map, and the labels or names of the polygons as points
in a point map. Now you will digitize a point map, containing the names of the units
in the map of Figure 3.15.

☞
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•

In the map window displaying the corrected segments, open the File menu
and select Create, Point Map. The Create Point Map dialog box is
opened.

•
•

Type Landunit in the Map Name text box.

•

Click the Create button next to the Domain list box. The Create Domain
dialog box is opened.

•
•

Type Landunit in the text box Domain Name.

Type for the Description: Points indicating the labels of land
unit polygons .

Select the option Class and click OK. The Domain Class editor is
opened.

➥
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➦

•

Press the Insert key or click on the Add Item button
Add Domain Item dialog box appears.

•

Add the domain item: Alluvial fan and click OK. Add also the domain
items: Infilled lake , Lake and Mountain .

•

Close the Domain Class editor. You are now back in the Create Point Map
dialog box.

•

Click OK. The Point editor and the Point Editor command box are opened
(Figure 3.5).

•

Digitize a point within each of the units indicated in Figure 3.15. See section
3.2 on how to digitize points (you can also do this with the mouse pointer).

•

When you are finished digitizing the points, click the Exit Editor button in
the Point editor. The point map Landunit is displayed on top of segment
map Checkseg .

in the Toolbar. The

Creating the polygon map
Now that the segments are checked and you have a label point file, you can proceed
with the polygonization.

☞

•

Click with the right mouse button on the segment map Checkseg in the
Layer Management pane, and select Edit Layer.

•

From the File menu of the Segment editor, select Polygonize. The
Polygonize Segment Map dialog box is opened.

At this point you have the possibility to polygonize the map using a point map with
labels (containing the name of the polygons), to use a domain, or to auto identify the
polygons (in which case default names will be assigned to the polygons).

☞

•
•
•

Select the option Label Points and select the point map Landunit .
Type Landunit for Output Polygon Map.
Type: Polygon map of land units for Description, accept all other
defaults and click OK. The segments are checked again and the map is now
polygonized. After the Polygonization the Display Options dialog box is
opened.

•

Click OK. The polygon map is shown. Click the units to find out their
names. You can also check the units in the legend.

•

Close the Segment editor.

The last step is to edit the polygons. In order to be able to edit it, you should first
break the dependency link between the polygon map Landunit and the segment
map Checkseg .
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☞

•

Double-click the word ‘Properties’ in the Layer Management pane. The
Properties sheet is opened.

•

Select the Dependency tab, click the Break Dependency Link button and
confirm with Yes.

•

In the map window open the Edit menu and select Edit Layer 1 Landunit .

Editing polygons
The Polygon editor and the Polygon Editor command box are opened. The
Polygon Editor command box only contains two options:
- Button 0: Edit Value: To change the name of a polygon.
- Button 1: No function.
- Button 2: Change Window: To change the area displayed on the screen.
- Button 3: No function.

☞

•
•

Zoom in on the area around E and F.

•
•

When finished, press the Exit Editor button.

If you forgot to add a label point to the three small lake polygons before, you
can edit the names of the polygons now. Double-click the units, select Lake
and press Enter ↵.
The polygon map Landunit is now ready. Close the map window when
finished.

If you want to practice some more with the creation of a polygon map, you can
digitize the landunit segments of Figure 3.14 yourself, do the segment check and
polygonize the segments.

☞
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•

Create a segment map Landunit2 , using the coordinate system
Cochabamba . Digitize the lines of Figure 3.15 in a similar way as explained
in section 3.3. Digitize all segments, including the boundaries of the map,
and make sure to snap all segments. All segments in the map may receive the
same code: Landunit2 .

•
•

Check the segments and correct the errors.
Create a point map Landunit2 , also using coordinate system
Cochabamba , digitize the labels, and use this point map together with the
segment map Landunit2 to create a polygon map Landunit2 .
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Summary: Digitizing maps
- Spatial data in ILWIS are digitized as point, segment or polygon maps.
- An individual point is defined by X and Y coordinates.
- A segment is composed of a series of intermediate points, connected by straight
lines, with a start and an end node.
- A polygon is a closed area consisting of one or more segments.
- Point, segment and polygon maps are digitized and edited with the Point editor,
Segment editor and Polygon editor respectively.
- The editors work in Select, Insert and Move Point modes. The Polygon editor
only has a Select Mode.
- You can add features to the selection, by clicking them while pressing and holding
the CTRL key. When you have completed the selection, release the CTRL key. To
select all points or pixels within a specific area, define a window enclosing them.
This window can be defined by dragging it with the left mouse button. To deselect
any of these features, press and hold the SHIFT+CTRL keys and click on the
selected features. When you have finished deselecting, release the SHIFT+CTRL
keys. To toggle between selected and deselected features, press and hold down the
SHIFT key, click the selected one to be deselected, and non-selected one to be
selected. When finished, release the SHIFT key.
- Segments are digitized either by continuously digitizing them (stream mode), or by
pressing the digitizer cursor only for some points along the line (point mode).
- A data reduction procedure called tunneling is carried out automatically, to reduce
the number of points defining a segment.
- In a segment map, generally, it is not needed to connect segments to each other,
except when it concerns linear features that will be used, e.g., in network analysis.
- In a polygon map, all segments forming a polygon have to be connected (snapped)
to each other at intersections. In other words, all boundary lines of polygons should
be snapped to each other at their nodes.
- Segments can be checked for Dead Ends (a node that is not connected),
Intersections without node (segment overlays without a node), and Self Overlap
(a segment that crosses itself). For contour maps, it is also useful to check for
Code Consistency (check if connected segments have the same code).
- Polygon maps are made by digitizing the boundary lines in the Segment editor,
checking the segments, and polygonizing them.
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- A domain type ID, class or value, can be selected for a new map. The domain of a
map is selected based on the data represented by the map, e.g. a domain type class
for a land use map, value domain for a segment map representing the contour lines.
- You can also use domain type Unique ID for new maps. If you like you can assign
user-defined names to the points, segments or polygons yourself.
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3.6 Additional information on digitizing photographs
Monoplotting on the digitizer
Monoplotting is the activity of digitizing segments and points from an aerial
photograph while correcting relief and camera tilt distortion. During digitizing the
software is transforming the gathered coordinates such that they fit on a topographic
map defined with a Cartesian coordinate system.
The transformation requires a DTM, in the form of a raster map, whose georeference
has the same Cartesian coordinate system, or at least a similar system which is
convertible into the one of the created segment or point map. The DTM is needed to
compute the distortions due to the relief in the terrain. To digitize on aerial
photographs you need to create a coordinate system Direct Linear or a coordinate
system Orthophoto. For more information refer to the ILWIS Help: How to
monoplot (on the digitizer).
Screen digitizing
In ILWIS it is furthermore possible to digitize a satellite image or scanned
photograph with the mouse pointer on your screen. Screen digitizing is the process of
creating and/or editing a segment or point map while an existing raster map is
displayed as a background in a map window. The raster map can be for instance a
band of a satellite image, a color composite, a scanned map, or a scanned photograph.
The background map or photo needs to have a georeference of type:
- Tiepoints: for satellite imagery;
- Direct Linear: when the photograph is taken with a normal camera;
- Orthophoto: when the aerial photograph is taken with a professional photogrammetric camera and has fiducial marks.
For the direct linear and orthophoto georeferences a DEM should be available. For
more information, refer to the ILWIS Help, topics How to screen digitize and How
to monoplot (on screen).
Orthophoto
An orthophoto is a rectified (north-oriented raster map with square pixels) scanned
photogrammetric aerial photograph with corrections for tilt and relief displacement.
An orthophoto is obtained by resampling a photograph which has a georeference
orthophoto to a georeference corners. For more information see ILWIS Help: How to
create an orthophoto.
From the ILWIS web site, you can download text and data for an exercise on creating
an orthophoto (see ILWIS 2.2 Guide).
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